It is frequently very useful to make line drawings of participants and

Drawing Figures in Framegrabs

other phenomena in Framegrabs:

* It is easier to hide the identities of participants, while retaining

vivid images of what they are doing.

* Line drawings (Vector Paths rather than collections of colored
pixels) can appear as much higher quality artwork than frame-

grabs in final publication (1200 dpi. versus 300 dpi)

* There is little quality loss when then are xeroxed.They do no

muddy up the way that images from framegrabs do.
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Father: [Sandra. R.eques?s
Sandra: LYeah. Orientation S\

Father: (Number) this one.
(1.3)
Sandra: [Twenty Five
Father: - Ten over six
Sandra: Yeah.
(0.6)
Father: ison:e
(1.0)
Father: ehh:en four si-four over six.
Reduce that down is one en two thirds

(0.5) Environmentally Coupled
Gesture
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Equipment
1) I highly recommend Adobe’s Creative Suite. It contains the
central graphics programs that | use all the time including
Photoshop, lllustrator, InDesign, and Acrobat Professional.

2) | prefer Macintosh Computers, but Adobe products (except for
Premier) work equally on Windows Machines.

3) A Drawing Tablet is immensely helpful. Rather than trying draw
intricate shapes with a mouse it allows you to use a pen. | use
a Wacom Intuos 6 x 8. | tried a smaller one and it wasn't useful.
The 6 x 8 is excellent. | highly recommend a tablet for drawing.
However it does cost money and you can do what is described
here with a standard mouse. |
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http://www.wacom.com/
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Overview of How to Make Drawings -

1)Use the Pen Tool in Photoshop by make Paths by drawing over, or
tracing the figures you want.

| \?'_l E@ @§ EO[QION\ [ | - au ceipene | [ E@ e —
806 * Laugh 1p Yo )
.Q;a:" | | : % — Dock to Palette Well
'1' |
E} . Save Path 3
f.-’: Ju ate Path...
b, 5, De!ete Path
.g-,J-,
3L Malke Wark Path
57 Make Selection...
1LY b Fill Path...
m ! Stroke Path...
'Lf-"lf Clipping Path...
= [=1E] -
|?* . D -’W Dalatéan Mintiane
2) Save the path(s ’ I - B " :E:II:I{:;ath.,.
: . Delete Path
3) Stroke these paths —— ¢ { ! i
- Either in Photoshop | \ A
with the Brush Tool Y N Ciipping Path..
« Orin lllustrator whereyou - =" =& e
select the paths you want .. NSy \
and stroke them. ~ - A \
3) Place Final Image in your InDesign Transcript. e ™ ~
Tool: | # Brush DN

) Simulate Pressure ( cancel ) DraWing 3



Setting Up a Photoshop File for Drawing

Drawing is easier if you first make a couple of helpful layers in your
Photoshop File.

1) Levels Adustment Layer (make image lighter)

2) New Layer Filled with White (see paths ea5|ly)

3) New Blank Layer Layers ‘Ghannels MPaths . " ()
" Normal @) Opacity: =

Lock: Fill: [ 100% B

All of this is done from the Layers Palette. A JeSle
The next pages describe how. ® Layer 1

5 M @ Levels 1

If you are going to making a number of
drawings you can create an Action in
Photoshop to make this set of layers

Y
r 1 Background a

@

automatically.
Go to the Actions, Palette, Record a New Action
and make all the layers, then stop recording.

EL A IEAERERE Y
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Setting Up a Photoshop File for Drawing ®o

1) Create a Levels Adjustment Layer. <>

IS

Normal m Opacity:
Lock: (1] 7% [@] Fill: [100% 8

'
£ @|_|:|_| Levels 1
R ] ’E Background a

-~ Channel:  RGB @

gim_‘ilm“ Input Levels: [0 | (201 | [255 | ( Cancel )

% i | (Load.. )

[=lojalelalal ¥/
e e o Auto
e =.

e || 21217

!;,.p-b“w L £ = ™ Preview

—Use the circular black and white icon on the bottom of the layers palette.
Move the center\pointer to the left to make the Image very light.

This makes it easy to see detail in dark areas.
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Setting Up a Photoshop File for Drawing ® 0

2) Create a new Layer and fill it (from the Edit Menu) with White. <>
:MWM% i Toggle the Visiblity of this Layer
«[Ol7+al it [100% 8 : " .
STl ] % To see clearly what your paths will look like.
® s Ju: . . . .
-=mm | o = — Invisible Visible
o e White Layer Whlte Layer
- R
it Mt (Normal  J8)  Opacity: [100% o) Normal : Opacity: | 100% |#
Lock: Fill: SO @_E;E@ Ll
® | [aye2 i ya

Layer 1 — !9 Euwri

-

ﬂ‘:’melsl Ealzllmlsl

& ‘ Background a . e I Sackground o i
ESL A AR Y [sela@lololalwls
- L | Leghaat 4 8 SRS e . RLRA8 ana 7 L 1 Lighter 1 8 1008 Biyer 2, ORI
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Setting Up a Photoshop File for Drawing

000

J Layers W ‘/6
Normal B Opacity: :
Lock: En Fill:
—
3) Create a new blank layer y O] Juve
Efforts to Stroke from the Path Palette ® Layer 1

Levels 1

will Fail if you don't have a layer to stroke in. [ |uld
IE Background a

EJL AN I AEEREERE R Y

@ O
< >

Drawing 7



Drawing with the Pen Tool

Vector Artwork: The drawings being made here are Paths.

Instead of being created like images in Photoshop — as operations
on specific pixels in the image— Paths are mathematical descrip-
tions of where lines will be drawn.

IE

I ETIETNAN R )

You use the Pen tool to create paths.

The Pen is very different from other draw-
ing tools in Photoshop, such as the Brush.

EOYER Y= he

Instead of drawing the shape you want
you set points where there will be signifi-
cant changes in the line.

4

/?_
e | PNl

For example to draw a straight line you
hit the screen where you want the line to
begin, then pick the pen off the screen,
and hit it again where you want it to en
You don't use the pen to draw the line
between these two points.

"

dl o]
) ®
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Curves: Points in the midst of curves have little handles on them.

Drawing with the Pen Tool

You adjust the shape of the curve by moving the handle.

The best way to understand, and become skilled in this, is

simply to play around a bit and experiment.

The Help Systems of both Photoshop and Illustrator
describe in detail how to use the pen to draw curves.
DO look at this. Here is part of the information from

Photoshop:

8eoe

Adobe Help Center

broduct H

Search Results for:
pen tool

[ Expert Support | » More Resources
|

To draw with the Freeform Pen tool r
Drawing curves with the Pen tool

To draw with the Pen tool
To use the Auto Erase option with the Pen
To use the Brush tool or Pencil tool

To create a new work path

To select a preset brush

To copy textures between tools

To set brush pressure sensitivity for digit
List of blending modes

To use the Eraser tool

To use the Background Eraser tool
Painting

To export paths to Adobe lllustrator

To record a path

Keys for selecting tools

Keys for selecting and moving objects
Keys for editing paths

Painting tools gallery

Drawing and type tools gallery

To change tool pointers

Using the options bar

About the Info palette

To paste Adobe lllustrator art into Photos -
Working with HDR images =

Entering type on a path LY

T allomlnistbon Adabon Folos Blalss 15l

[<a] > [@]| (@] [3] 8] [B] Help for: Adobe Photoshop CS2 ] Q- pentool

Drawing curves with the Pen tool

You create curves by dragging the Pen tool in the direction you want the
curve to go. Keep these guidelines in mind when drawing curves:

* Always drag the first direction point in the direction of the bump of the
curve, and drag the second direction point in the opposite direction to
create a single curve. Dragging both direction points in the same
direction creates an "5” curve.

— Y B\‘

e

PR \

Drag in the opposite direction to create a smooth curve. Drag in the
same direction to create an 57 curve.

« When drawing a series of smooth curves, draw one curve at a time,
placing anchor points at the beginning and end of each curve, not at
the tip of the curve.

To decrease the file size and reduce the potential for printing errors,
use as few anchor points as possible, and place them as far apart as
possible.

( Previous Topic ) ( Next Topic )

> ) @
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< >

Drawing 9

m. '.-_.



Setting up the Pen Tool ® 0
You must actually make a couple of selctions in both the Side and <>
Top toolsbars to work correctly with the pen.
-Side Toolbar: Select the Pen Too.
-Top Toolbar: Make sure you select the little, middle icon, with the
pen surrounded by paths:

EI @ @I\ (::_? '!_'Auto Add/Delete

In the Paths Palette
Fill Shape Create a New Path
Pixels ~ Layers (or Save the one there
if you have already started)
200 P —
r:‘.f_? e Dock to Palette Well
. Wovk fa & Save Path...
Duplicate Path...
Delete Path
Make Selection...
Fill Path...
@ f Stroke Path...
4= _a Clipping Path...
o /
S p q Palette Options... Drawing 10




3 Pen Tools ® o
There are actually 3 Pen Tools <>

1) Pen Tool -- Hit to add points and shape curve with handles
2) Freeform Pen Tool — Just Draw and Points are Added Automatically
3) Freeform with Magnetic — Pen will try and follow shapes in image.

BlE - Bl SEEEeNG T ~ W

| usually use the
“ij“ Tool o Basic Pen Tool.
o] o | Wul@lo N agnevic | [ .
| The Magnetic

Freeform Magnetic
sounds great, but

Pen Tool
frequently our
images are too
muddy to give the
tool sharp contrasts
to work with.

Make Paths by
Setting Points &
Adjusting Handles Pen Will Try to Follow Iti
End Path by Draw Over Surface & Line in Picture tIs easy to get
Command Clicking Points Added While Adding Points . y . 9
Outside Path Automatically Automatically Jagged Wlth the
End Path by HI'Etnt'd Pa&ytby F f P

(Otherwise Path Ends
Will Join to
Create a Filled Shape)

Note that you end each type of path in a different way.
Until you realize this it can be a hassle to stop adding points,
or you suddenly find yourself with a filled path you don’t want.

Releasing Mouse
Button

Drawing 11



Drawing with the Pen Tool ® o

The best way to learn to use the Pen Tool is to <>
1) Look at the Instructions in Photoshop Help .
2) Play and Practice a bit. Toggie your White Layer

g

It quickly becomes something your hands know how to dg.____‘___ér——“
Basically
1) Click where you want to add a point.
Don't lift up the mouse button.
Move the button slightly in the direction
you want the line to go.
This will begin the handle for the line. |
2) Adjust the handles so that the line follows
the shape of what you tracing.

Toggle Again to draw the

Both move the handle around & Path While Looking at your Image
change its shape. | . = —
3) Hit the Command key to adjust points. B i
You can move the point and adjust handles. (@) o
v.a|:’ .
: .'i.:'gcw_l
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Reshaping Paths with the Path Selection Tools ® o
To Experiment with Drawing with the,

Pen Tool it might be useful to take

2| 5 something very simple, such as the
ZiiE ) path for an eyebrow. As you set the
0‘ ™ firsts point move the mouse up and to

N PathSeiection Tool A the right to start the curve.

[* Direct Selection Tool A

Just above the Pen Tool on the Left
Toolbar are the Tools for Selecting
Paths. There are 2.

The Path Selection Tool (solid arrow)
allows you to select a whole path, for
~ example to move it.

The Direct Selection Tool (hollow
arrow) selects particular points within
a path. You can reshape a curve by
adjusting the handles on the points.

When using the Pen Tool you can go to
the Path Selection Tools immedieately
by holding down the Command Key.

Drawing 13



Drawing Suggestions ® o

N | s When drawing clothing it is frequently _
' useful to include some of the folds and
wrinkles in the clothing.

t When you want draw a curve, say the

| end of finger, it’s best not to add a

L point at the high point of the curve,
but instead put points on each side of
it, and use the handles to shape the
curve.

Drawing 14



Stroking Paths in Photoshop 1 STE—

| Lay {Paths *, _
" Norm B Opacity: 100% B < >

Paths themseleves are invisible. To make them visible

you have to Stroke them. There are 2 ways to do this, o[ Jum )
one in Photoshop itself, and another in lllustrator. d E‘ﬁ—/
) & M:@E’Lw 1
'Z} érush: E) Mode: ' Normal | Photoshop: "_ “T— 5
\/ IE 2 I 2ERE R R
- 1) Make sure you have an empty
p': layer to write your strokes.
:0z8 _ 2) Select the Brush Tool with Black
g,\ H T CTh & as a Co!or and a Brush Width Qf
I say 5 pixels (do Experiment with
7@ ,
5l the width).
RJT, 3) Select the Path in the Paths Pal-
LIRS ette.
5, ”,
DK
L
=iirw
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Stroking Paths in Photoshop 2 Tra— N
h N o = = e <>
@) Mo R I'.I 5'. l Layer 2

PR < AL e )

L1 27 AR A1 noZ A G =L

77 T FE S

%a ﬁ. . = . 'k:_ 5 Sackground a

=2 i"_ P\ by R Photoshop: eeleaTeIsTaTal”

5] ; / Aftering Selecting the Path in the Paths
gRl—— P Palette.

-
B 4) Select the Paths in the Drawing with
?ol.: 4 Brush — H G'—‘-‘éii: the Path SeleCtiOn TOOI.
| 5) Stroke the path, either from the pull

down menu on the right of the pal-
ette, or with the button like an empty
circle at the bottom of the palette.

6) Save this as a Photoshop PSD file (to

maintain layers etc.), then Flatten it
and Save the Stroked Image as a Tiff
to put in InDesign.
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Stroking Paths in Illlustrator

| prefer to stroke paths in lllustrator which is included in Adobe’s Creative

@ O
< >

Suite) because you have more control..

IGIH edt image (ayer Select Filter View Window Extensis
New.. #N
Open... ®0
Browse X#0
Open Recent »

Ed t n mageReady TEM
Close E
Close Al NHW
Close and Go To Bridge. TBW _ f—— _
Save 5 Save As- [ FSDREIuE Drawing 2]
Save As. i3 33 e L
Save for Web xous B
nnnnn P Sam Y

Revert
Place.

mport

Paths to lllustrator...

Au'l_omate Send Video Preview to Device
Scripts Video Preview

F e nfo. No® ZoomView

Page Setup Q8P

Print with Preview. Y¥P

Print ®P

Print One Copy Xoxp

Print On ne /

lllustrator

1) Export the paths to lllustrator (you
will be given a choice for Path
Names to export).

2) Open lllustrator

3) Open this File in lllustrator.
When the file opens it will be
blank.

This is because none of the paths
r have yet been stroked or filled.

>-_ 4) Hit CommandY to view the paths
in Outline View.
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Stroking Paths in Illlustrator @0

L : : < >
One advantage of working in lllustrator is that you can easily make some
lines thicker than others. For example you might want the outline of the
face to have thicker, bolder lines that the eyes, or the outline of a piece of
clothing to bolder (thicker) than the wrinkles within.
— . 1) In the lllustrator Layers palette
= "[— [ ] Arrow 5~ makea setof layers (created from
| [ o the bottom up):
T B [ | [Jmi O \Thick,Thin, Fill, Arrow
LR, TE hic -
o= BEE ] e < You can rename the original layer
§,T. Thick stroke. Initally it will contain
}‘ E,‘ j ﬁ\\ \.\),,<,, o all of the paths in the file.
= T % / \,’ S e 3 o - .
] =8, ,«%@?‘[ = \: | :@:‘:::: o8 You can create an Action from the
Al OV— ' i
= j o <O\T—“\\ Actions Palette to make all these
Blat) NS layers.Wh lay |
e ( S\\gy/ ayers.When you play it you may
2% o/ s have to hit Return at each layer.
D : :
Ho 2) Using the Selection Tool (top left
WIEY on the left tool bar) move all the
1-; .
paths you want to be thin to the

Thin Stroke Layer. Drawing 18



Stroking Paths in Illlustrator @0
When you've moved all the thin <

paths to that layer
3) Lock the Thin Layer.

4) Go to the Thick Layer, use Com-
mand A to Select All Paths and
then give them a Black Stroke of
say 4 points (Experiment)

RN
G N EEIRE

@ - A
[y [y (S
'
"
s ||

= 5) Now give all the paths in the Thin
E ] Layer a stroke of 2 Points
2% : :
N (Lock the Thick layer; Select All
X< in the Thin Layer)
VIEN

6) Hit Command Y to go to Preview

\___ Vew, and see the drawing will all
of its stroked paths.
7) Save this file to Place in your
InDesign Transcript (you may get

something about Converted in
the Save Box -- Ignore it)

C

n
o
Ll

el
(]
@.

Drawing 19



@ O
< >

Adding Arrows

Arrows are extremely useful. You can add them either when you are draw-
ing paths in Photoshop or later in lllustrator.

-Photoshop
Choose the line tool from the left toolbar. In the options on the top toolbar

chose the end(s) of the line where you want arrowheads:
Eventually you will

S want to Fill the
= arrow shape
P: % ‘ Length: [500% p —'_'.';:._

. ¢ [concaviey 5% AN
\ F _—
77 pusiny
é‘ 4 . I\ t'_‘::____ / ",.-" \-. |
, [ 4 e . {077 O
) .l T SN~/
! k v I .__,__..‘__;‘:. l"., l.‘ﬁs- - s /
I\\ I s t._- I.l-' {" / ) _:;'- L N
- | -Tf ‘-_-:‘/_ - -,
LI e y \ / S |
- -, A“l !'Il i - _.A"" . -/ II
. S _— ) yd _____i |I
T T i /
- ——— _l'_ T ~— ~/
I." - |1'r y /
—_— e . '!. I|I A,
a ."I N ' Drawing 20




Adding Arrows lllustrator @0
Draw a path (the shaft of your arrow) with either the Pen Tool or the Line <>
Tool.

With the path selected choose Effect ->Stylize -> Add Arrowheads. A box
will appear allowing you to chose what end(s) of the line you want. You
control the size of the arrowhead with the Scale at the bottom of the box.

You can adjust the arrowhead later from the Appearance Palette where it
appears as an Effect.

DON'T add arrowheads from the Filter menu. The Arrowhead won't appear
as an effet in the Appearance menu for later adjustment.

%
Add Arrowheads Ap v -~
k k i Add Arrowheads... NAE
{‘—D) Cancal ) Document Raster Effects Settings... P
\,& lustrator Effects ﬁ:a:ngam 40
rl 4
=] None 5 2 E soke I 27
o, Convert to Shape b = -
. ne 4
j Endt: Distort & Transform b —
s Path S s _
—> Default Tramsps
“\J =y pathfinder 2 KX s ool 515 1/
@ Nt = 1of27 =5 Rasterize
4 Add Arrowheads...
== Scale: |100 % Dron Shadows :
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